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THE WINNING TEAM COLLECT THEIR PRIZE AT THE VERY SUCCESSFUL CHARITY TABLE QUIZ IN THE RATOATH INN.





LOTTO RESULTS 14- 2- 06


NUMBERS DRAWN 7,10,15,27.


NO JACKPOT WINNER                               THE €50 WINNERS WERE 


Niall O Brien c/o R.H.                        Michael Fox c/o R.H.                          Conor Falvey c/o R.H.               Paul Plunkett c/o R.H.


NEXT WEEKS JACKPOT IS €5000 AND THE DRAW WILL TAKE PLACE IN THE AULD STAND


(On duty Martin & Alan)

















Your By-line


Your Company Name


This document was created using linked text boxes, which allow articles to flow continuously across pages. For example, this article continues on page two, while the one to the right continues on page three. When you add lines of words to a text box, the words in the following text box flows forward. When you delete lines of words from a text box, the words in the next text box moves backward. You can link several text boxes in an article, and you can have multiple articles in a document. The links do not have to occur in a forward direction.


Inserting Linked Text Boxes


To insert linked text boxes in a document, click Text Box on the Insert menu. Click and drag in your document where you want to insert the first text box, and insert additional text boxes where you want the text to flow.


To select the first text box, move the pointer over the border of the text box until the pointer becomes a four-headed arrow and then click the border. Click the right mouse button, click Create Text Box Link and then click in the text box where you want the text to flow. Repeat these steps to create links to additional text boxes.


In the first text box, type text that you want. As the text box fills, the text will flow into the other text boxes that you’ve linked. To let the reader know that an article will continue on another page, insert a small text box under the text box, choose the Jump To style, and then type the words “Continued on Page.” Click Cross-reference on the Insert menu. Choose Heading from the Reference type drop-down list, and Page Number from the Insert Reference To. Select the name of the follow-up heading from the For Which Heading list box and then click Insert.


Formatting Text Boxes


You can change the look of linked text boxes by using color, shading, borders, and other formatting. Select the text box you want to format and then double click its border to open the Format Text Box dialog box. If you want to change the color or borders on a text box, choose the Colors and Lines tab. To change the size, scale, or rotation, click the Size tab. To change the position of the text box on the page, click the Position Tab.  If you have other text surrounding the text box, and want to change the way the text wraps around it, click the Wrapping tab. If you want to format all the text boxes in an article, you must format them individually - the formatting on one text box will not apply to the others in the sequence. 


Using Linked Text for Parallel Articles


You can use linked text boxes to flow text in parallel  “columns” from page to page. This method gives different results than using the Column command on the Format menu, which causes text in column 1 to flow or “snake” to column 2 on the same page. By using linked text boxes, you can instead have text from column 1 flow to column 1 on the next page. The text beside it in column 2 can flow to column 2 on the next page, parallel to column 1. This technique is useful if you need to group two similar articles, for instance, an article translated in English on the left and the same article translated in French on the right. 


To flow text in parallel, display paragraph marks in your document. Click at the top of the page where you want the side-by-side columns to start, and press Enter twice. Click in the first paragraph mark on the page. On the Insert menu, click Text Box and drag on the page where you want the first column. Click Text Box again and then click and drag where you want the second column. Click in the last paragraph mark on the page, and press Ctrl + Enter to create a page break.


Repeat the process for each page that will contain side-by-side columns in your document and then return to the first text box you created. Click the text box on the left once to select it. Click your right mouse button and then click Create Text Box Link. The pointer becomes a pitcher. Click the text box on the left side of the second page to create a link. Create links for all text boxes within the same article on the left side of the document. Repeat the process for every text box in the right chain or article.


Pressing Enter twice at the top of each page will create an extra empty paragraph. This blank paragraph is useful if you want to insert text or graphics outside of the text boxes. You can delete the extra blank paragraph if you don't need it.


Copying linked text boxes


You can copy an article or a chain of text boxes that are linked together, to another document or to another location in the same document. To copy linked text boxes and the text they contain, you must copy all the linked text boxes in an article. Select the first text box in an article. Hold down Shift, and click each additional text boxes you want to copy. On the Edit menu, click Copy. Click where you want to copy the text boxes and then click Paste.


To copy some of the text from  an article, select the text you want to copy from the article and then copy it. Do not select the text box. You can paste text you’ve copied directly into your document, into another location within the same article, or into another article.(





RATOATH HARPS


ANNUAL DINNER DANCE


ASHBOURNE HOUSE HOTEL


Saturday 25th February 2006


Four Course Dinner---Live Music---Dancing---Live D.J.


Dinner 9pm Sharp


      


Tickets €50                      8pm `till late.





Tickets available from:


Hazel O Connor:   086-8147442.


Joan O Sullivan:   087-2232627.


Danny Keenan:    086-8414510.








MANAGER REQUIRED





Ratoath Harps are currently looking for a manager for their reserve team.


The team plays in Div. 1c (Sat.) of the Leinster Senior League.         


For further information contact Brian Conway at 087-6888960





SAT. 18th  FEB.


L.S.L. Ratoath Harps v Rosemount 2oC A


Clifford Cup O/35’s v Rivermount 2-30 H


D.D.S.L. 11A1v Verona 10-30 H (Cup)





BRENFER N.D.S.L.


8C v ?


8D1 v Swords Rovers 10oC A


8E v Swords Celtic 11-30 A


9E v St. Ita’s 10oC H


9E1 v ?


10B v Rush Ath. 11oC H


10D1 v ?


10E2 v Rush Ath. 11-45 A











FIXTURES SUN. 19th FEB.


L.S.L. Ratoath Harps v Dundrum 2oC A


D.D.S.L.


8D v Cambridge Boys 10-30 H


9B1 v Iveagh Trust 11-15 H


10B1 v Valeview Shankill 12oC A 


BRENFER N.D.S.L.


11A v Glebe North 10oC H


11D v Kinsealy Boys 10oC H


12Premier v Malahide Utd. 11-15 H


12D v Drumcondra 11-15 H


12E v Beaumont 10oC A


13Premier v Shelbourne 11oC A


13C v Castleknock 10oC A


13E v no game


14A v no game


14E v Dunboyne 12-30 H


15C v East Meath 12-30 H


17A v Swords Celtic 20C H








NEW WEBSITE LAUNCHED


 Ratoath Harps have just launched their new improved website with the considerable help of former player Jeff Sheridan, director of Matrix Internet Solutions, and Aaron Conroy. The new website gives information on all aspects of Ratoath Harps and is being improved and updated regularly. The site will be of interest to former, existing and intending members as well as the general public. The Harp Newsletter can also be accessed and you can print your own copy of current or previous editions.


www.ratoathharps.com 





�








SIOBHAN AND DAVY O NEILL PLAY TO A RELATIVALY SMALL CROWD IN VERONICA BORDELLO DURING CHRISTMAS.





The Harp is an information leaflet produced by Ratoath Harps F.C. with the assistance of Philip Wallace & Oltech-Olivetti, National Distributors of copiers, fax, printers and supplies. 





MAGNIFICENT DUFF INSPIRES VICTORY

















Keith Byrne taken down for penalty.   Willie Creagh back in 1st. Team action.      Goalkeeper Gary Duff





Ratoath Harps goalkeeper Gary Duff was in outstanding form as he helped his team to overcome Howth Celtic in a penalty shootout in Ratoath last Friday night. The stakes were high as the winners would be in the last sixteen of the Leinster Junior Cup and this incentive brought out the best in both teams. Howth started well and had The Harps under pressure, but a powerful run from Keith Byrne ended with a penalty kick when he was fouled as he shot for goal. Steve Hyland converted to give Ratoath a 1-0 lead after fifteen minutes. This inspired the team and with Keith Byrne raiding down the right wing and sending in some great crosses the Howth keeper was called on to make several saves, with Gareth Wilson and Jordan Lancaster going close with headers. Ratoath continued to attack in the second half and great play from Jordy created a chance for Keith, which went over the bar. The strong Howth team then got the upper hand and scored thirty minutes into the second half with a powerfully headed goal from a corner kick. Ratoath were now under pressure but defended well to send the game into extra time. The pace of the game increased, as both teams looked for a winning goal much to the delight of the large crowd and Marcus Cowser almost scored for Ratoath in the first period of extra time but was bravely blocked by the keeper. Howth took over in the second period but failed to score due in no small part to some outstanding defence from Danny Lonergan and brilliant goalkeeping from Gary. The penalty shootout could rightly be called the Gary Duff Show, as his display had to be seen to be believed. He displayed all his agility as he saved the first three well-taken penalties from Howth. Steve Hyland, Gareth Wilson and Keith Byrne expertly converted their penalties to separate two evenly matched sides. TEAM: Gary Duff, Danny Lonergan, Steve Hyland, Derek Kavanagh, Robbie Kelly, Keith Byrne, Damian Lynch, Gareth Wilson, David Hempenstall, Marcus Cowser, Jordan Lancaster. SUBS: Mark Hennessy, Willie Creagh, Colm Curry, Joey Burke.


Ratoath Harps first team fixture against Templeogue on Friday 17th has been deferred and instead they are away to Dundrum on Sunday 19th.   Kick off is at 2oC.

















RATOATH HARPS 


ALLWEATHER PITCH


REDUCED RATES APPLY AT WEEKEND


The all –weather pitch is also available for Football Parties and is very popular for birthdays and other occasions


For further details


Phone 087-2444627 or 8256396





�








A LITTLE THOUGHT





 When things in your life seem almost too much to handle, when 24 hours in a day are not enough, remember the mayonnaise jar and the coffee. A professor stood before his philosophy class and had some items in front of him. When the class began, wordlessly, he picked up a very large and empty mayonnaise jar and proceeded to fill it with golf balls. He then asked the students if the jar was full. They agreed that it was. So the professor then picked up a box of pebbles and poured them into the jar. He shook the jar lightly. The pebbles rolled into the open areas between the golf balls. He then asked the students again if the jar was full. They agreed it was. The professor next picked up a box of sand and poured it into the jar. Of course, the sand filled up everything else. He asked once more if the jar was full. The students responded with a unanimous "yes". The professor then produced two cups of coffee from under the table and poured the entire contents into the jar, effectively filling the empty space between the sand. The students laughed. "Now," said the professor, as the laughter subsided, "I want you to recognise that this jar represents your life. The golf balls are the important things -- your family, your children, your health, your friends, and your favourite passions -- things that if everything else was lost and only they remained, your life would still be full. "The pebbles are the other things that matter like your job, your house, your car. The sand is everything else -- the small stuff". "If you put the sand into the jar first," he continued, "there is no room for the pebbles or the golf balls. The same goes for life. If you spend all your time and energy on the small stuff, you will never have room for the things that are important to you. Pay attention to the things that are critical to your happiness. Play with your children. Take time to get medical check-ups. Take your partner out to dinner. Play another 18 holes. There will always be time to clean the house, and fix the disposal. Take care of the golf balls first, the things that really matter. Set your priorities. The rest is just sand". One of the students raised her hand and inquired what the coffee represented. The professor smiled. " I'm glad you asked," he said. "It just goes to show you that no matter how full your life may seem, there's always room for a cup of coffee with a friend."



































PH. 8256396 OR 087-2444627


E-MAIL theharp68@iolfree.ie


WEBSITE: www.ratoathharps.com





GREAT WIN FOR U-17 TEAM





The U17's were given a tough draw in their cup competition when they were pitched against Huntstown Villa's U18's. The Harps were clearly up for the game from the first whistle and got at the opposition with great determination. Both teams played good football with chances going to both sides during the first half but none were taken. The second half started at a blistering pace and early on it was clear that The Harps were getting the upper hand. Huntstown were always dangerous but when called upon The Harps back four were really working well together. On the couple of rare occasions that the visitors did create chances, thanks to great defensive work by in particular Brian Colgan, they came up against Harps Keeper Matthew O Byrne-White who was in great form. With a change to the usual formation the lads played with five in midfield which saw them winning most of what happened in that area. Kevin Walls returned to the starting line up after injury and with the usual battling performance from him and midfield partner Andrew Salama the Huntstown players knew they were in a game. Jordan Finlay was left to play up front on his own and with a couple of minutes left in the game got his reward. The Harps were awarded a corner, which was delivered superbly to the back post and put away by Jordan for what was the only goal of the game. This was a great result for the team, who are top of their league and still in their league cup competition. Team, M O’Byrne White, K Timoney (Capt.) P Higgins, B Colgan, S Turley, I Davis, K Walls, A Salama, J Harte, B Snowe, J Finlay, Subs, R Foran, J Fitzgerald, L Halpin, D McGill.











IT’S SAFER FLYING?


Taxiing down the tarmac, the 757 abruptly stopped, turned around and returned to the gate. After an hour-long wait, it finally took off. A concerned passenger asked the flight attendant, "What was the problem?" "The pilot was bothered by a noise he heard in the engine," explained the flight attendant," and it took us a while to find a new pilot."�





�











CREDIT UNION OF RATOATH


Phone 8257055         Fax 8257173


OPENING HOURS


Monday


 6.00 p.m. to 9.00 p.m.


Tuesday


 9.15 a.m. to 12.30 p.m.


Thursday


. 9.15 a.m. to 12.30 p.m.


2.00 p.m. to 4 p.m.


Friday


 9.15 a.m. to 12.30 p.m.


6.00 p.m. to 9.00 p.m.


Saturday


 10.30 a.m. to 12.30 p.m.
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